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Chapter 1 Introduction

This chapter includes:

Section 1: Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Section 2: User Groups  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Section 3: Documentation Conventions . . . . . . . . . . . . . . . . . . . 9
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Section 5: Software License; Intellectual Property . . . . . . . . . . 11

Section 7: Revision History. . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Section 1: Overview

The Inventory Management (IM) Tool is a component of the Demand 
Management Suite and an add-on application of the Demand 
Management Engine (DME). This guide will teach you how to use the 
Inventory Management Tool so you can manage your inventory 
efficiently to decrease unnecessary expenses and increase ROI. The 
figure below is a depiction of the Demand Management Suite. Inventory
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Chapter 1
Management is one of the products of that suite. It works as an add-in 
component in the Demand Management Engine.

1-1: Inventory Management Tool Highlights

Maximizes your profitability margin by gauging inventory 
levels and expenses.

Manages inventory to meet forecasted demands.

Establishes safety stock levels to meet unexpected 
demands.

Maintains service levels.

1-2: Logging In

You can access the IM Tool by logging into the DME application. You 
must have a DME username and password to use the IM Tool and do 
not need a separate username and password. Please contact your 
Rev 0 8



Chapter 1
System Administrator if you forgot or do not have a username and 
password.

You can change your password in the Base Unit when you log in.

Note: Usernames and passwords are case sensitive.

1-3: Logging Out

If you would like to log out of the application, in the DME Viewer, click 
on File > Exit.

Section 2: User Groups

User groups and privileges are dependent upon permissions granted 
by the System Administrator. The System Administrator configures 
the Inventory Management Tool for individual users or user groups. 
Please contact your System Administrator if you have questions 
about your user privileges.

Section 3: Documentation Conventions

3-1: Text 

The following table lists text conventions in this user guide.

Table 1-1: Default Username and Password

Log In Password

Username fxadmin

Password fxadmin
Rev 0 9
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3-2: Screen Captures

The example screens in this guide may not represent what you see 
on your monitor; use them only as guidelines.

Section 4: Acronyms and Abbreviations

Table 1-2: Text Convention Descriptions

Convention Description

Text represented as a screen display. This typeface represents displays that appear on your 
terminal screen, for example:

lom>

Text represented as menu or sub-menu 
names.

This typeface represents all menu and sub-menu 
names within procedures, for example:
On the File menu, click New.

Table 1-3: Acronyms and Abbreviations used in this Manual

Term Definition

DME Demand Management Engine

IM Tool Inventory Management Tool

DRP Demand Replenishment Planning

BOM Bill of Materials

PO Purchase Order

UOM Unit of Measurement
Rev 0 10
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Section 5: Software License; Intellectual Property

5-1: Preamble

Any software provided to the customer is subject to the specific 
license terms and conditions of the applicable agreement, or shrink-
wrap, or click-wrap license.

In the event of any conflict between those specific terms described 
below, the specific terms will supersede and prevail.

QAD Inc. agrees to those terms and are provided as 
follows.

5-2: License Grant

QAD Inc. grants to Customer a limited non-transferable 
license to use the Licensed Software subject to the limitations 
imposed under this Agreement and to the following:

The Permitted Users shall use the Licensed Software only on the 
equipment located at the Site. Customer must obtain a 
supplementary license from QAD Inc. (which QAD Inc.  
 may or may not grant, at its option) before using the 
Licensed Software.

Customer may make one copy of the Licensed Software in machine-
readable form solely for backup purposes and shall reproduce on any 
such copy the copyright notice and any other proprietary labeling of 
QAD Inc. that were on the original copy.

Customer shall comply with all restrictions on the use of Licensed 
Software that Customer is subject to as a licensee or sublicensee of 
QAD Inc. under the terms of licenses or other agreements 
or arrangements by QAD Inc. with third parties.

5-3: Restrictions

Except as necessary for Customer to exercise its express rights 
hereunder, Customer may not itself or allow any third party to (i) make 
copies of the Licensed Software, (ii) distribute the Licensed Software 
Rev 0 11



Chapter 1
to others, (iii) electronically transfer the Licensed Software from one 
computer to another over a network, or (iv) decompile, reverse 
engineer, disassemble, or otherwise reduce the Licensed Software to 
a human perceivable form. CUSTOMER MAY NOT MODIFY, ADAPT, 
TRANSLATE, RENT, LEASE, LOAN, RESELL FOR PROFIT, 
DISTRIBUTE, NETWORK, OR CREATE DERIVATIVE WORKS 
BASED UPON THE LICENSED SOFTWARE OR ANY PART 
THEREOF.

5-4: Ownership of Media

The media on which the Licensed Software is recorded or fixed is 
Customer's property. If Customer receives Licensed Software 
hereunder that renders Licensed Software that Customer has 
previously received redundant, Customer will return the redundant 
Licensed Software to QAD Inc. or certify in writing that all 
copies of such Licensed Software have been erased.
Rev 0 12
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Section 7: Revision History

Rev Date Author Reason For Changes

0 9/2006 HDB Initial release for Inventory Management 
Tool 3.0
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Chapter 2 Installation

This chapter includes:

Section 1: Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Section 2: Requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Section 3: Installation Process  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Section 1: Overview

The IM Tool is an add-on of the DME; you must have DME installed on 
your computer in order to install the IM Tool. After the installation is 
complete, the Inventory tab displays in the Viewer and the IM Tool icons 
are enabled. Please see “IM Tool at a Glance” on page 74 for additional 
information.

The IM Tool consists of five components. The Installation Wizards for 
each component launch automatically and chronologically when you 
begin the installation process. Each component is installed on either the 
client or server.

Table 2-1: Inventory Management Tool Components

Component Description Installed on

Admin Tool Creates inventory management configurations. Client

Inventory Bridge 
Deployment

Enables you to run the IM Tool from the Viewer. Client

Inventory 
Runner 
(Standard)

Also known as Calculations. Enables you to run inventory 
calculations.

Please note that the Inventory Runner is installed in a 
separate folder from the other components.

Server

Database 
Upgrade

DB Administration Tool for IM Tool enables you to upgrade 
the database automatically, as well as provide information for 
the DB and the directory for the Inventory Runner.

Server

PO Launcher Enables you to submit POs based upon Inventory results. Client
Rev 0 14
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Section 2: Requirements

As mentioned above, the installation process for the IM Tool is 
automated. However, there are certain hardware and software 
requirements necessary to ensure the application installs successfully.

2-1: Hardware

The list below details the required hardware to install the IM Tool.

2-2: Software Media

The list below details the required software to install the IM Tool.

Inventory Management Module 5.2 CD

Demand Management Engine 4.5 CD

Windows 2000/2003/XP

Safety Stock 
Simulator

Enables you to determine optimum safety stock levels. Client

Table 2-1: Inventory Management Tool Components

Component Description Installed on

Table 2-2: Hardware Requirements

Hardware Minimum Recommended

CPU Pentium 3 - 700 MHZ Pentium 4 - 2.0 GHZ
Pentium M - 1.2 GHZ

RAM 256 MB 512 MB

Hard Disk 50 MB 100 MB
Rev 0 15
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.NET 2.0 

ADO 2.8

Installer 3.1

Note: You can download and install .NET 2.0, ADO 2.8, and Installer 3.1 
from www.microsoft.com.

Section 3: Installation Process

The following sections detail how to install the IM Tool. 

3-1: Prerequisites

The list below details the prerequisites prior to beginning the installation.

Demand Management Engine installed.

A Living Master Scenario (or a default DTL Scenario).

3-2: Installing the Inventory Management Tool

1. Insert the Inventory Management Module 5.2 CD into the CD drive.

2. Click on SetupInventory.exe.
Rev 0 16
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The Demand Management Suite Setup Welcome window displays.

3. Click Next.

5.2

Demand Management
Rev 0 17



Chapter 2
The License Agreement window displays.

4. Click I Agree.

QAD, INC

QAD, INC

5.2
Rev 0 18
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The Installation Mode window displays.

5. Select how you would like the IM Tool to be installed. If the server is 
on the client machine, then install both. If the server is on a separate 
machine, then install the server side first and then install the client 
side on each user’s computer. 

It is recommended that you install both the client and server 
components.

6. Click Next.
Rev 0 19
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The Client Side Setup Wizard window displays. The application 
prepares to install the client.

7. Click Next.

Demand Management

Demand Management

Demand Management
Rev 0 20
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The Select Installation Folder for the client displays.

8. By default, the application installs itself in the directory shown above. 
To choose a different location, click Browse.

To view the disk space available on your computer, click on Disk 
Cost.

Select Everyone to allow anyone to access the IM Tool from your 
computer or Just Me to allow only yourself access.

9. Click Next.

5.2

Demand Management

Demand Management

Demand Management
Rev 0 21
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The Confirm Installation window displays.

10. Click Next.

Demand Management

Demand Management
Rev 0 22
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The Installation Wizard finishes installing the client and the 
Installation Complete window displays.

11. Click Close when finished.

 Demand Management

Demand Management
Rev 0 23
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The client has been installed successfully. The Server Side Setup 
Wizard window displays. The application prepares to install the 
server.

12. Click Next.

 Demand Management

Demand Management

Demand Management
Rev 0 24
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The Select Installation Folder for the server displays.

13. By default, the application installs itself into the shown directory in the 
illustration above. To choose a different location, click Browse.

To view the disk space available on your computer, click on Disk 
Cost.

Select Everyone to allow anyone to access the IM Tool from your 
computer or Just Me to allow only yourself access.

14. Click Next.

5.2

Demand Management

Demand Management

Demand Management
Rev 0 25
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The Confirm Installation window displays.

15. Click Next.

Demand Management

Demand Management
Rev 0 26
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The Installation Wizard finishes installing the server and the 
Installation Complete window displays. The Inventory Management 
Tool icons are now enabled.

16. Click Close when finished.

Demand Management

Demand Management
Rev 0 27
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The client has been installed successfully and the Database 
Administration Tool for DRP window displays.

17. Select a name for the server in the Server Name drop down box and 
type in a name for the database in the Database Name text box. Use 
the SQL Server Username and Password. Click Upgrade Database if 
you want to perform an upgrade the database. 

Note: Upgrading the database resets all the tables related to the DRP.  To 
ensure data is not lost, you must remember to backup your tables.

18. Click Exit if you do not want to change any configurations.

The IM Tool has been installed when the Installation done window 
displays. 

5.2

Demand Management
Rev 0 28
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ent 
3-3: Inventory Management Tool Functional Check

After you have gone through the installation process, you should check to 
see if the IM Tool has been installed successfully. 

1. Log into the Viewer. 

Start > All Programs > Demand Management Suite > Demand Managem
Engine > Viewer.

2. Check to see if Inventory is listed at the top of the toolbar with all of its 
features accessible.

The table depiction below lists all of the IM Tool features.

You are now ready to configure the IM Tool for users; this is discussed in 
Chapter 3 Configuration.
Rev 0 29
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This chapter includes:

Section 1: Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Section 2: Creating an Entity. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Section 3: Assigning an Entity to a Scenario  . . . . . . . . . . . . . . . . . . . 40

Section 4: Configuring the Inventory Management Admin Tool Toolbar44

Section 1: Overview

The IM Admin Tool enables you to use the Forecast feature as a demand 
baseline in order to determine Recommended Orders and calculate 
inventory positions. However, before users can use the application, you 
must create an Entity and assign it to a Scenario.

Section 2: Creating an Entity

An entity is a specific collection of specifications for inventory 
management. You can create an entity in the Viewer of the DME.

1. Log into Demand Management Engine and go to Viewer > Inventory 
> Admin Tool. 
Rev 0 30
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The Inventory Management Admin Tool displays, as well as the 
Inventory Entities window.

2. Go to Edit > Create. Alternatively, you can click on the  icon on 
the toolbar.
Rev 0 31
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The Inventory Entity Creation window displays with the Time Level 
screen. 

3. The Time Level chooses which level the Forecast is run. The default 
setting is Monthly. If you would like to change the time increments, 
select Weekly or Daily. The Number of cycles area is greyed unless 
you choose Custom, which enables you to determine the number of 
cycles per year.

Calculate daily DRP determines the level of DRP Output. Click Yes if 
you would like the DRP to run at the Daily Level; No if you want the 
DRP to run at the same level as the Forecast.

Note: For the DRP to execute properly, Entity Time Level and Scenario 
Time Level need to match.

Note: Daily DRP must be configured in order to enable BOM Support and 
PO Launcher capabilities.
Rev 0 32
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The DRP Integration window displays.

4. Select Yes in the Input additional daily opinion line if you have 
additional daily opinion lines to use; the default setting is No. 

If you do not want to export the output, click No in Output daily 
opinion line option; the default setting is Yes.

In DRP Link Field, choose the mapping field between the input table 
and Series table. If you would like to change the linked field settings, 
you can select a different link from the list in DRP Link Field; this 
feature links input/output to the Forecast.

The External Tables are predefined.

Note: If you are not running a Daily DRP, then these options are disabled.

5. Click Next.
Rev 0 33
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The DRP Method window displays.

6. The DRP Method measures inventory needed beyond open orders. 
To choose the default settings, click Next. If not, select the 
calculations that you would like configured for your new entity. The 
table below depicts how each calculation can be configured.

Table 3-1: DRP Method Calculations

Calculation Description

Demand 
Calculation Logic

Determines which type of calculation can be used. Can 
be configured for a specific series.

Safety Stock 
Type

Used as a buffer for inventory. Each selection 
determines when the forecast alerts you when stock 
needs to be replenished.
Rev 0 34
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The following tables provide more detailed information about the DRP 
Method Calculations.

Replenishment 
Type

Determines when recommended order should be 
released.

Calculate Action 
Message

Reviews existing orders and current inventory to give 
proper action message.

Demand 
Calculation 
Logic

Description

No Basic 
Demand

Demand is not calculated and the input is added 
manually.

Forecast only Uses Forecast and is the default demand type.

Open Order only Uses Open Orders to calculate demand.

Demand 
Consume Logic

Uses the maximum Forecast minus history and Open 
Orders.

Max of Forecast 
and Open Order

Uses Forecast or Open Order, whichever is higher, for 
each period.

Safety Stock 
Type

Description

Coverage Based upon the number of periods covered. If Safety 
Stock needs to cover two periods, the input is 2. 
Coverage is in addition to Replenishment. 

Statistics Calculates a Safety Stock based upon the stability of 
the Forecast.

Table 3-1: DRP Method Calculations

Calculation Description
Rev 0 35
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.

.

Internal Manual input of the Safety Stock that disregards any 
calculations.

Replenishment 
Type

Description

Reorder Point If the amount of stock is below a certain amount, the 
application reorders the stock. Generally used for 
lower volume items.

MinMax Calculates when to order inventory so that levels 
always remain between the previously set minimum 
and maximum range.

Calculate 
Action Message

Description

Yes Notifies you if an existing order needs to be cancelled 
or expedited.

No Does not notify you if an existing order needs to be 
cancelled or expedited.

Safety Stock 
Type

Description
Rev 0 36
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The BOM Support window displays.

7. To choose the default settings, click Next. Click Yes if you would like 
the BOM settings to be configured. The BOM Configuration section is 
then activated. 

Select a field from the BOM Link Field drop down box. The Link Field 
is the link between the BOM Table and the Series Table (i.e., a 
mapping between the tables). If you would like to select more series, 
check the Series Link Field 1 and/or 2 boxes.

Select an Order Field from the Order Field drop down box.

Note: Daily DRP must be configured in order to enable BOM Support.
Rev 0 37
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The DRP Attributes window displays.

8. You would use an external attribute table if you wanted to maintain 
attributes on an outside table or if you are using the DRP attributes on 
a higher level (for example item vs. item-site), it removes redundancy. 
If you would like to use an external source of data, click Yes. In 
Attribute Link Field, choose the mapping field between the input table 
and Series table. 

Click Next when finished.
Rev 0 38
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The PO Launcher window displays.

9. You would select Use Series Attributes if an attribute of a series, like 
price, is always the same, regardless of quantity purchased.  When 
using Use External Budget Information, you can specify limits that will 
define the price for an item depending on the amount purchased.  
This is representing a volume discount and it can be set for as many 
as five different attributes.

In order to run the IM tool in a Scenario or Series, you must assign 
the entity you have just configured to that Scenario.

Note: Daily DRP must be configured in order to enable PO Launcher.

Note: You must have permissions to enable the PO Launcher and edit the 
PO Budget Information. Please see the Demand Management 
Engine Manual for additional information.
Rev 0 39
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The New Inventory Entity window displays.

10. Type in a name for the entity you just created. Click Save when 
finished. 

For additional and more configurations for the IM Tool, see Advanced 
Configurations.

Section 3: Assigning an Entity to a Scenario

You must assign the entity to a scenario through the Assignments feature. 
To assign an entity to a scenario:

1. Open the IM Admin Tool from the Viewer and go to Inventory > Admin 
Tool.
Rev 0 40
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The Inventory Management Administrator Tool with the Inventory 
Entities window displays.

2. Click on the entity you would like to assign to a scenario. 
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The Inventory Entity displays with the configurations you had 
selected.

3. Click the Assignment tab. 
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4. Assign the entity to a scenario.

5. Click OK when finished.
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6. The Inventory Management calculation displays in Graph View. You 
can review the calculation in Data View, Demand Data or Series 
Information by selecting the appropriate tab.

Section 4: Configuring the Inventory Management Admin 
Tool Toolbar

You can configure the IM Admin Tool toolbar to display the features 
available.

1. Click on the icon at the top of the IM Admin Tool toolbar.
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2. Click Add or Remove Buttons.

3. Hover your mouse over Tool Bar. 

The IM Admin Tool features are listed. 

4. Select those you want on your toolbar. You can also click on Reset 
Toolbar to revert to the default settings.
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Section 1: Overview

The IM Tool can be installed with the default configurations. However, you 
can continue to configure the application to meet specific criteria. The 
sections below provide detail on how to perform advanced configurations 
for the IM Tool.

Section 2: Daily DRP

The Daily DRP feature can be used even if the forecast is not calculated 
in days (i.e., weekly, monthly, by periods).  This is also true for the Lead 
Time attribute.  This enables the user to release orders on a daily level, 
rather than on a monthly level. 

To enable the Daily DRP feature.

1. Go to Inventory > Admin Tool.
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The IM Admin Tool window displays.

2. Right-click the entity you would like to edit from the Inventory Entities 
window.

3. Select Edit.
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The Inventory Entity window displays.

4. Click on the “Click here to open the Inventory configuration wizard” 
button.
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The Inventory Entity Time Level window displays.

5. In the Calculate daily DRP area, select Yes and click Next.
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The DRP Integration window displays.

6. In the Input additional daily opinion line and the Output daily opinion 
line sections select Yes, then click Next. In the DRP Link Field, 
choose the mapping field between the input table and Series table.

7. Click Next until you reach the PO Launcher window and click Finish.

You can now view the Input by gong to Inventory > Input Daily Detail.  
To view the Output, run the DRP calculations before going to 
Inventory > Daily View. 

Note: When the Daily DRP is enabled, the DRP Inventory Date should be 
entered in the following formats:  yyyy-mm-dd or the local date setting 
format (for example mm/dd/yyyy for the U.S.).
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Section 3: Assignment tab

Please see Assigning an Entity to a Scenario for additional information.

Section 4: Attributes tab

Depending upon how you configured an entity during General 
Configuration in “Creating an Entity” on page 30, you can customized the 
DRP Attributes for the entity. New Attributes can be defined so that you 
can use the values of these Attributes later to control the way Opinion 
Lines behave and, ultimately, how DRP works.

To select one or more of the attributes from the list:

1. Go to Inventory > Admin Tool.

The Inventory Management Admin Tool window displays.

2. Right-click on the entity to which you want to edit an attribute and 
select Edit. 

3. Click on the Attributes tab.
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The list of Attributes displays.

The following table details what each column means.

Column Description

Attribute Name Name of each Attribute. This parameter is used 
internally by the application and can only contain 
alphanumeric values.

Caption Text field used to more accurately describe each 
Attribute. This field is used to reference the attribute in 
the Opinion Lines tab, when using it in formulas.  This 
field can contain alphanumeric values and 
underscores.
Rev 0 52



Chapter 4
4. Scroll through the list of Attributes.

Note: You can click on the columns’ headings to arrange the calculations in 
decremental or incremental order.

5. Click on the Is Calculated checkbox in the last column of the list.

6. Click Apply.

7. Click Cancel to not save your changes.

Data Type Defines the data type of the new Attribute. A combo 
box is provided with the options available. Please see 
See “Data Type” on page 76. for possible data types.

Default Value Used to give each attribute a default value in case the 
user has not specified a field for this attribute in the 
Series or DRPAttribute tables, or the value in the field 
is null or an empty string. 

Input Table This column is used to specify from where the Attribute 
is going to be read.  These are the possible values:

None - This is only used for special Attributes that 
are used in DRP calculations. A user created 
attribute should never use this as its input table.
Series - This is the Series Table of the DME.  This 
is the information displayed in the 'Series Attribute' 
tab in the viewer when a scenario is open.
DRPAttribute - This is a special table created for 
the Inventory module in which you can define 
custom Attributes to use in your entities.

Input Field Specifies which field of the Input Table is used for the 
Attribute. The valid values for this field depend on the 
option selected for input table:

If Input table is DRPAttributes, then you can select 
the following fields: STR_ATTR01 - STR_ATTR20 
and QTY_ATTR01 - QTY_ATTR20.
If Input table is Series, then all other fields are valid, 
except the range of fields mentioned above.

Is Calculated Specifies whether or not the Attribute is calculated. 

Column Description
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4-1: Deleting an Attribute

You can delete an Attribute from the Entity.

1. Select the Attribute that you want to delete by checking the Is 
Calculated checkbox in the last column of the list. You can select 
more than one attribute at a time.

2. From the Attributes tab, click on the icon.

The Inventory Management Admin Tool window displays.

3. Click Yes to delete the Attribute from the entity.

Note: Deleting an Attribute that you did not create may cause problems.  
Please delete with caution.

4-2: Adding an Attribute

You can add an Attribute to an entity.

1. From the Attributes tab, click on the  icon. 

A row is added to the end of the list of attributes.

2. Add the necessary information for the Attribute.

3. Click Apply.

4. Click Cancel to not save your changes.
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Section 5: Opinion Lines tab

You can change Opinion Lines values as needed. Opinion Lines can also 
be defined as custom formulas for any number of Opinion Lines using 
Attributes and Constants. To edit an Opinion Line's formula, select the 
Opinion Line and double-click on it. When editing Opinion Line's formulas, 
there are two columns: Parameter Name and Parameter Value.  
Depending on the type of Opinion Line, you have the option to define no 
or multiple parameter names.

Depending upon how you configured an entity during General 
Configuration in “Creating an Entity” on page 30, you can customized the 
Opinion Lines for the entity. 

To update one or more of the Opinions from the list:

1. Go to Inventory > Admin Tool.

The Inventory Management Admin Tool window displays.

2. Right-click on the entity to which you want to edit an Opinion and 
select Edit. 

3. Click on the Opinion Lines tab.
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The list of Opinion Lines display.

4. Scroll through the list of Opinions.

The table below details what each column means.

Column Description

Opinion Name Name of the Opinion Line used by the application. It 
can only contain alpha-numeric values, no white 
spaces or special characters.

Caption Text field used to more accurately describe each 
attribute. This field can contain alpha-numeric values, 
underscores and white spaces.
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Default Value Used to give each Opinion Line a default value in case 
the user has not specified an input field value for this 
Opinion Line. The possible values for this column 
depend on the value selected for Type. The default 
value can only be a number, if the Opinion Line is type:

Abs
Calculate
Cumulate
CvgDmd
CvgDmdNext
Divide
Max
Min
Multiply
PerCvg
PlusMinus
ShiftedLine

The default value can be either a number or a string 
when the Opinion Line Type is Input or Case; this 
depends on the attributes that are used in the formula.

Type Used to define the type of Opinion Line. Note that the 
type of an Opinion Line can be changed only by the 
parameter editor. The editor is activated by double 
clicking on the Opinion Line. Please See “Opinion 
Lines Type” on page 85. for additional information.

Update Used if an Opinion Line will be affected after DRP 
calculations run.

Description Short description of what each Opinion Line 
represents.

Expandable Used to indicate if the Opinion Line should be 
expanded.  This is used, for example, when taking data 
from a scenario that is at a monthly level and 
expanding it to a daily level.

Column Description
Rev 0 57



Chapter 4
Exp. Mode This column indicates what operation is going to be 
done when expanding an Opinion Line.

None - No expand operation.
Percentage - Use this mode to spread the Opinion 
Line's value to each day.  For example, it takes a 
monthly value and evenly distribute it among the 
days within the month.
Same - Use this to copy the Opinion Line's value to 
each day.  For example, if you have a monthly 
value, it copies that exact same value to each of the 
days in the month.

Compressible Opposite of the Expandable column. It indicates if an 
Opinion Line should be compressed from daily to 
another time level, such as months or weeks.

Cmp. Mode This column indicates what operation is going to be 
done when compressing an Opinion Line.

Average - takes an average of all the daily values 
and make an average to save to the corresponding 
period.  For example, if the user has a monthly 
scenario, then to go from daily to monthly, it will take 
all the values for the Opinion Line's days, make an 
average and display that in the corresponding 
month.
First - takes the value from the first day that has 
information and put that as the period value.  So if 
there was a value on the 1st of January of 320, then 
the whole month of January will display 320.
Last - displays the last value found in the daily 
information.  So, for example, in December, it will 
display the value the Opinion Line has for 
December 31st.
Max - displays the maximum value of all the ones at 
daily level and display it in the upper level.
Min - displays the minimum value of all the ones at 
daily level and display it in the upper level.
None - does nothing; it is selected when 
compressible is disabled.
Sum - displays the sum of all the values at daily 
level and will show that sum at the upper level.

Column Description
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Note: You can click on the columns’ headings to arrange the list in 
decremental or incremental order.

5. Select the Opinions that you want to have expanded and compressed 
by checking the Expandable and Compressible check boxes.

6. Click on the Update check box in the fifth column of the list.

7. Click Apply.

8. Click Cancel to not save your changes.

Input Table When an Opinion Line is type Input, this column 
indicates from where that Opinion Line gets the values.  
There are two possible values:

DRPInput - this is a table created for DRP that can 
be used to add additional Opinion Lines.
Observations - this is the Observations table in the 
database, used by the DME.

Input Field This is the corresponding field from the Input table, 
selected in the Input Table column:

When Input table is DRPInput: Input field can be any 
of the following QTY_LINE01 - QTY_LINE25.
When Input table is Observations: Then input field 
can be any valid field from the observations table.

Output Table 
Default

Used when the period (such as monthly) result of an 
Opinion Line should be output. The only table allowed 
is the Observations table, for this version.

Output Field 
Default

Specifies the field in the observations table in which the 
Opinion Line are saved.

Output Table 
Exploded

Specifies when the daily result of an Opinion Line 
should be output. The only table allowed is DRPOutput 
table, for this version.

Output Field 
Exploded

Specifies the field from the DRPOutput table to which 
the Opinion Line is saved.

Column Description
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5-1: Deleting an Opinion Line

You can delete an Opinion Line from an entity.

1. Select the Opinion that you want to delete.

2. From the Opinion Lines tab, click on the icon.

The Inventory Management Tool window displays.

3. Click Yes to delete the Opinion from the entity.

5-2: Adding an Opinion Line

You can add an Opinion Line to an entity.

1. From the Opinion Lines tab, click on the  icon. 

A row is added to the end of the list of Opinions.

2. Add the necessary information for the Opinion Line:

3. Click Apply.

4. Click Cancel to not save your changes.
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Section 6: Stored Procedures tab

The Stored Procedures tab contains the Stored Procedures that are used 
to perform the calculations and input/output of inventory management.  It 
also includes stored procedures used to customize the inventory 
behavior. Those stored procedures are blank by default, so that the user 
can customize them to perform special inventory logic.

Depending upon how you configured an entity during General 
Configuration in “Creating an Entity” on page 30, you can customized the 
Stored Procedures for the entity. 

1. Go to Inventory > Admin Tool.

The Inventory Management Admin Tool window displays.

2. Right-click on the entity to which you want to edit a Stored Procedure 
and select Edit. 

3. Click on the Stored Procedures tab.
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The list of Stored Procedures display.

The following table details what each column means. Note that the only 
editable columns in the stored procedure tab are the Signature column 
and the allow refresh option. The remaining columns are updated 
automatically accordingly to user changes in the entity or when the 
'Refresh SP's' button is used.

Column Description

Event Name of the event that the Stored Procedure 
represents.

Signature Actual name of the stored procedure. Whenever the 
Stored Procedures are refreshed they are created with 
the names that are displayed in this column.
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4. Scroll through the list of Stored Procedures.

Note: You can click on the columns’ headings to arrange the columns in 
decremental or incremental order.

5. Uncheck the Allow Refresh checkboxes to ensure that customized 
stored procedures settings are not changed during a refresh.

6. Click on the Refresh SPs button to refresh the list.

7. Click Apply.

8. Click Cancel to not save your changes.

Section 7: PO Search tab

The PO Search feature chooses the search criteria for users. You can 
then decide if you want it viewable in the Recommended Order 
spreadsheet. Depending upon how you configured an entity during 
General Configuration in “Creating an Entity” on page 30, you can 
customize the PO Search to search by specific Attributes for the entity. 

To update one or more of the PO Searches from the list:

1. Go to Inventory > Admin Tool.

The Inventory Management Admin Tool window displays.

2. Right-click on the entity to which you want to edit a PO Search and 
select Edit. 

Allow Refresh Indicates whether or not the stored procedure should 
be refreshed automatically when the Entity 
configuration changes and when the user clicks the 
"Refresh SPs" button.

Params Displays the parameters that are sent to each of the 
stored procedures.

Column Description
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3. Click on the PO Search tab.

The list of PO Searches display.

The table below details what each column means.

Column Description

Caption The name of the item. PO launcher uses it for the 
caption of the item.

Series A Series Attribute mapped to this search item.
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4. Scroll through the list of PO Searches. The list of search criteria is in 
the Caption column. Choose the Caption to use and map the 
corresponding link.

Note: You can click on the columns’ headings to arrange the columns in 
decremental or incremental order.

5. Select which Series you want the PO Search to include by clicking on 
the Series column header and choosing a series.

6. Check the UseForSearch checkbox to use that specific search criteria 
for the PO Search.

7. Check the ShowInGrid checkbox if you want to see that specific 
search criteria in the PO Search.

8. Add a comment in the Note column to provide more information.

9. Click Apply.

10. Click Cancel to not save your changes.

7-1: Deleting a PO Search 

You can delete a PO Search from an entity.

1. Select the PO Search that you want to delete.

UseForSearch A flag indicating whether this item is used for search or 
not. It is possible that an item is used for showing the 
value in the recommended order grid table only (i.e., 
item description). 

ShowInGrid This flag indicating whether this item is shown in the 
recommended order grid table or not. It is possible that 
an item is used for search but does not show in the grid 
table, e.g., the supplier ID.

Note The note for this item.

Column Description
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2. From the PO Search tab, click on the icon.

The Inventory Management Admin Tool window displays.

3. Click Yes to delete the PO Search from the entity.

7-2: Adding a PO Search 

You can add a PO Search to an entity.

1. From the PO Search tab, click on the  icon. 

A row is added to the end of the list of PO Searches.

2. Add the following information for the PO Search:

Caption

Series

UseForSearch

ShowInGrid

Notes

3. Click Apply.

4. Click Cancel to not save your changes.
Rev 0 66



Chapter 4
Section 8: PO Budget tab

The PO Budget feature enables users to find Purchase Orders that fit 
within certain parameters (i.e., cost and size). The PO Budget feature 
configures the Budget Limit feature in the PO Launcher. Depending upon 
how you configured an entity during General Configuration in “Creating an 
Entity” on page 30, you can customized the PO Budget for the entity. 

To update a PO Budget from the list:

1. Go to Inventory > Admin Tool.

The Inventory Management Admin Tool window displays.

2. Right-click on the entity to which you want to edit a PO Budget and 
select Edit. 

3. Click on the PO Budget tab.
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The list of PO Budgets display.

The table below details what each column means.

Column Description

Caption The name of the budget constraint. PO launcher uses 
it for the caption of the constraint.

Series Displays when Series Attribute constraint is used. A 
series attribute mapped to this constraint.

UOMType Displays when external budget constraint is used. A 
UOMType used to identify the corresponding 
constraint.
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4. Scroll through the list of PO Budgets.

Note: You can click on the columns’ headings to arrange the columns in 
decremental or incremental order.

5. Click on the Caption text box and type in what you would like the PO 
Budget to calculate. Your edits that are displayed in the Budget Limit 
area of the PO Launcher.

6. Click on the UOMType text box and type in how you would like the 
PO Budget to be calculated. Your edits then are displayed in the 
budget Limit area of the PO Launcher.

7. Click Apply.

8. Click Cancel to not save your changes.

8-1: Deleting a PO Budget

You can delete a PO Budget from an entity.

1. Select the PO Budget that you want to delete.

2. From the PO Budget tab, click on the icon.

Type The type of the budget constraint. There are three 
types:

Cost - the constraint of this type is also used to 
calculate the total cost of the PO in the PO header 
table. This type shows a currency symbol for the 
constraint output.
Price - the constraint of this type indicates that the 
PO system should show a currency symbol for the 
constraint output.
Other - the constraint of this type is only for 
constraint calculation, and no currency symbol for 
the output.

Column Description
Rev 0 69



Chapter 4
The Inventory Management Admin Tool window displays.

3. Click Yes to delete the PO Budget from the entity.

8-2: Adding a PO Budget

You can add a PO Budget to an entity.

1. From the PO Budget tab, click on the  icon. 

A row is added to the end of the list of PO Budget.

2. Add the following information for the PO Budget:

Caption

UOM Type

3. Click Apply.

4. Click Cancel to not save your changes.

Section 9: Safety Stock Settings

You can configure the Safety Stock Settings for users. 

1. Go to Inventory > Safety Stock > Settings.
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The Safety Stock Settings window displays.

2. From the Safety Stock tab, select the criteria from each section that 
you want to configure.

3. From the Demand tab, select which Observation field you would like 
to be calculated for the Total Demand.

4. From the Cost tab, select which Series Field you would like to 
calculate and the Observation Field for Time Phased Cost.

5. Click Save when finished.
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Note: Safety Stock Settings should match those in the Inventory Entity; this 
is not done automatically. These settings are used for both the Safety 
Stock Simulator and Safety Stock Calculator.

Section 10: Importing an XML File

You can import an XML file to an entity.

1. Go to Inventory > Admin Tool. 

2. Right-click the entity to which you would like to import an XML file.

3. Select Import from XML File. Alternatively, you can click on the  
icon on the toolbar.

Note: There are two different files to select when importing an entity: Entity 
XML file and Entity Schema file.
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The Open an Inventory Configuration file window displays.

4. Browse for the XML file and click Open.

The XML file is then imported to the entity.

Note: When an Entity is imported and the newly imported entity uses a 
name different from the original, then you will need to change the 
Stored Procedure's name manually.

Section 11: Exporting an XML File

You can export an XML file to an entity.
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1. Go to Inventory > Admin Tool. 

2. Right-click the entity to which you would like to export as an XML file.

3. Select Export from XML File. Alternatively, you can click on the  
icon on the toolbar.
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The Save As window displays.

4. Type in a name for the file in the File name: text box.

5. Click Save.
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Appendix A Attributes Tab

This chapter includes:

Section 1: Data Type. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

Section 2: Attributes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Section 1: Data Type

Table A-1: Data Type

Data Type Description

Bool Boolean variable and it only accepts two values, 1 for 
TRUE and 0 for FALSE.
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Date For Date Attributes created by the user the correct date 
format depends on the values contained in the 
specified Series field. If the selected Input field has 
values in the format yyyy/mm/dd then the default 
values specified here should have the same format.
There are two specific cases for a couple of attributes 
created by the system that have the Date type:

startPeriod and endPeriod - even though these 
two attributes are Date types they always represent 
forecast periods.  So if you had a scenario with 
weekly time level this attribute should have values in 
the format yyyy-ww, where ww is the week number 
(2007-52 for example).
Yesterday - this Attribute represents the date for 
yesterday and should be in one of the following two 
formats: yyyy-mm-dd or dd/mm/yyyy.
invDate - this parameter format depends on 
whether the entity has been configured for daily 
output or not.  When daily output has been enabled 
for the entity, the format should be either yyyy-mm-
dd or dd/mm/yyyy.  When daily output is disabled, 
this attribute behaves like startPeriod and 
endPeriod; it will represent a forecast period. The 
format is yyyy-pp.

Decimal Decimal value. Take note that if you create a new 
attribute with a type decimal this will not match any field 
that does not contain decimals.  For example, if the 
Attribute has a default value of 2.0 and the series field 
has 2, then the application will not consider this a 
match.

Integer Integer value. Only integer values without decimals are 
accepted.

String String value. Any string is accepted as a default value 
but remember that these values are CASE 
SENSITIVE, so when matching against default values 
be sure to use the correct case.

Table A-1: Data Type

Data Type Description
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Section 2: Attributes

The table below details all the Attributes that exist on newly created 
Entities. Note that each series (item) has its own value for each Attribute.

Table A-2: Attributes

Attribute Name Data Type Description Usage/Notes

seriesID Integer Series ID of the current item Internal usage

firstFcstPeriod String First forecast period Internal usage

lastFcstPeriod String Last Forecast period Internal usage

yesterday Date Yesterday’s date. Internal usage. This 
attribute is used in Inventory 
Date when no Inventory 
Date has been set.

orderMultiple Decimal The recommended order 
should be a multiple value of 
this setting.

roundUpThreshold Decimal

minOrder Decimal The minimum number of 
orders that can be 
recommended by the system 
in DRP calculations.

maxOrder Decimal The maximum number of 
orders that can be 
recommended by the system 
in DRP calculations.

startPeriod Date The first period on which DRP 
calculations will begin.

This attribute is generally 
set to match the first 
forecast period of the 
scenario.
Rev 0 78



Chapter A
endPeriod Date The last period on which DRP 
calculations will execute.

This attribute is generally 
set to match the last forecast 
period of the scenario.

invDate Date The date from which the initial 
on hand inventory will be 
taken into account.  Note the 
initial on hand is the ending 
inventory for the specified 
inventory date.

This attribute is generally 
set to yesterday.

allocPct Decimal The allocation percentage for 
the whole season, when initial 
loading strategy is used.

Only useful when initial 
loading strategy is used for 
very seasonal items, such 
as a Halloween-only item.

maxInit Decimal The maximum initial loading, 
when initial loading strategy is 
used.

Only useful when initial 
loading strategy is used for 
very seasonal items, such 
as a Halloween-only item.

userIntLoad Bool The flag to indicate that initial 
loading strategy is used.

Only turn this flag on when 
initial loading strategy is 
used for very seasonal 
items, such as a Halloween-
only item.

leadTime Integer The order lead time. It 
specifies how many units of 
time (days, weeks, months, 
etc) it takes to receive an 
order after it has been 
released.  

When using Daily DRP, 
leadTime is assumed to be 
in days; If Daily DRP is 
disabled then leadTime is 
represented in the scenarios 
time level as periods.  For 
example, if lead time =1 
then in scenario with weekly 
time level means 1 week.

invOnhand Decimal The initial on hand.

Table A-2: Attributes

Attribute Name Data Type Description Usage/Notes
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safetyStockType String The type of Safety Stock used 
in the DRP calculation.

The possible values are:  ‘I’ 
for Statistical, ‘C’ for 
coverage and ‘N’ for 
internal.

replenishmentType String The type of replenishment 
used in the DRP calculations. 

‘M’ for Min/Max, which 
specifies a minimum and a 
maximum of inventory that 
should exist and then keeps 
the Inventory between those 
lines by recommending 
orders accordingly. ‘R’ for 
Reorder Point, this method 
triggers a re-order when 
inventory is below the 
minimum.

demandType String The type of Demand used in 
the DRP calculations.

The possible values for this 
attribute depend on which 
options where enabled for 
the entity. All the available 
options are: ‘F’ for Forecast 
only, which only takes the 
Forecast Opinion Line as 
the demand.  ‘O’ for open 
orders only.  ‘N’ to have no 
basic demand.  ‘M’ for the 
maximum between forecast 
and open orders. ‘C’ for 
demand consume logic, 
which uses forecast, actual 
shipment and open orders 
to calculate demand.

allowRollOver Bool The flag to indicate whether 
unsupported demand is rolled 
over as demand for next 
period or not.  

Table A-2: Attributes

Attribute Name Data Type Description Usage/Notes
Rev 0 80



Chapter A
useLastCommDate Bool The flag to indicate whether 
the system should 
recommend order before the 
last committed order date.

If this attribute is set to 
TRUE, then the system will 
not recommend any order in 
dates prior to the last 
committed order it finds.  If 
the parameter is false, then 
DRP will recommend orders 
regardless of the committed 
orders already present.

saveBatchSize Integer The number of the outputs in 
one store procedure. This 
attribute is an advanced 
setting used for performance 
improvement only.

hasDept String The flag to indicate whether 
this item has dependent items 
or not. The value of this flag is 
set internally by the system. 

This attribute is used when 
BOM Support is enabled. 
Make sure do not use this 
field for other usage, 
because the value in this 
field will be overwritten by 
the DRP calculation.

orderMultiple Integer Series ID of the current item Internal usage

roundUpThreshold String First forecast period Internal usage

minOrder String Last Forecast period Internal usage

maxOrder Date Yesterday’s date. Internal usage. This 
attribute is used in Inventory 
Date when no Inventory 
Date has been set.

startPeriod Decimal The recommended order 
should be a multiple value of 
this setting.

endPeriod Decimal

Table A-2: Attributes

Attribute Name Data Type Description Usage/Notes
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invDate Decimal The minimum number of 
orders that can be 
recommended by the system 
in DRP calculations.

allocPct Decimal The maximum number of 
orders that can be 
recommended by the system 
in DRP calculations.

maxInit Date The first period on which DRP 
calculations will begin.

This attribute is generally 
set to match the first 
forecast period of the 
scenario.

userIntLoad Date The last period on which DRP 
calculations will execute.

This attribute is generally 
set to match the last forecast 
period of the scenario.

leadTime Date The date from which the initial 
on hand inventory will be 
taken into account.  Note the 
initial on hand is the ending 
inventory for the specified 
inventory date.

This attribute is generally 
set to yesterday.

invOnhand Decimal The allocation percentage for 
the whole season, when initial 
loading strategy is used.

Only useful when initial 
loading strategy is used for 
very seasonal items, such 
as a Halloween-only item.

safetyStockType Decimal The maximum initial loading, 
when initial loading strategy is 
used.

Only useful when initial 
loading strategy is used for 
very seasonal items, such 
as a Halloween-only item.

Table A-2: Attributes

Attribute Name Data Type Description Usage/Notes
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replenishmentType Bool The flag to indicate that initial 
loading strategy is used.

Only turn this flag on when 
initial loading strategy is 
used for very seasonal 
items, such as a Halloween-
only item.

demandType Integer The order lead time. It 
specifies how many units of 
time (days, weeks, months, 
etc) it takes to receive an 
order after it has been 
released.  

When using Daily DRP, 
leadTime is assumed to be 
in days; If Daily DRP is 
disabled then leadTime is 
represented in the scenarios 
time level as periods.  For 
example, if lead time =1 
then in scenario with weekly 
time level means 1 week.

allowRollOver Decimal The initial on hand.

useLastCommDate String The type of Safety Stock used 
in the DRP calculation.

The possible values are:  ‘I’ 
for Statistical, ‘C’ for 
coverage and ‘N’ for 
internal.

saveBatchSize String The type of replenishment 
used in the DRP calculations. 

‘M’ for Min/Max, which 
specifies a minimum and a 
maximum of inventory that 
should exist and then keeps 
the Inventory between those 
lines by recommending 
orders accordingly. ‘R’ for 
Reorder Point, this method 
triggers a re-order when 
inventory is below the 
minimum.

Table A-2: Attributes

Attribute Name Data Type Description Usage/Notes
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hasDept String The type of Demand used in 
the DRP calculations.

The possible values for this 
attribute depend on which 
options where enabled for 
the entity. All the available 
options are: ‘F’ for Forecast 
only, which only takes the 
Forecast Opinion Line as 
the demand.  ‘O’ for open 
orders only.  ‘N’ to have no 
basic demand.  ‘M’ for the 
maximum between forecast 
and open orders. ‘C’ for 
demand consume logic, 
which uses forecast, actual 
shipment and open orders 
to calculate demand.

Table A-2: Attributes

Attribute Name Data Type Description Usage/Notes
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Appendix B Opinion Lines Tab

This chapter includes:

Section 1: Opinion Lines Type  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

Section 2: Opinion Lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

Section 1: Opinion Lines Type

Table B-1: Opinion Lines Types

Type Description

Abs Returns the absolute value of the selected parameter 
base line. This type of Opinion Line only allows one 
parameter and the parameter can only be a BaseLine 
parameter.

Calculated Specifies that the Opinion Line is calculated by the 
DRP engine. This type of Opinion Line does not allow 
any parameters.

Case Enables the user to create a formula that incorporates 
conditional logic into the Opinion Line. The parameters 
for this type of Opinion Line can be:

Switch - There can only be one switch parameter 
per formula.  The parameter value associated with 
this Switch parameter must be an attribute selected 
from the dropdown list.  Base line value is ignored 
for Switch.
Case - There can be any amount of case 
parameters in each formula.  The Parameters value 
can ONLY be a constant; the type of constant will be 
determined by the Attribute chosen for the Switch 
parameter.  Base line can be any Opinion Line the 
user wants.  If the Opinion Line is selected to be 
output to another table, then the data types should 
be compatible. 
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Constant Used to define a Constant. nly one parameter can be 
defined, the parameter name is Value and the 
parameter value must be a constant and an Attribute.

Cumulate Defines an Opinion Line that cumulates a specific 
Opinion Line through out time.  These Opinion Lines 
can only have one Parameter.

CvgDmd Can only have two parameters, and returns the next 
'CvgPerLine' periods of 'ConsumeLine'. For example, if 
the value of CvgPerLine is 3, and ConsumeLine is the 
total demand Opinion Line, then this Opinion Line 
outputs the sum of the total demand for the current 
period and the next two periods; it adds 3 periods of 
demand in total.

CvgPerLine - This can be any other Opinion Line, 
and it represents the number of periods that you 
want to be added from the ConsumeLine 
parameter.
ConsumeLine - This is the Opinion Line from which 
the periods will be taken from.

CvgDmdNext Similar to CvgDmd type, but instead of taking the 
periods starting on the current period, it starts taking 
the periods from one period into the future.

Divide Used to divide values. There can only be 3 parameters:
BaseLine1: This is the numerator in the calculation.
BaseLine2: This is the denominator in the 
calculation.
ZeroValue: When the denominator is zero, the value 
in this opinion is used.

Input Opinion Lines with this input type cannot have a 
formula associated with them. When an Opinion Line 
has this type, the value is taken from the field specified 
in the Input Field column.

Table B-1: Opinion Lines Types

Type Description
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Max Used to get the maximum value from a set of Opinion 
Lines. The only parameter name is Base Line and 
there can be any number of them.

Min This type of Opinion Line is used to get the minimum 
value from a set of Opinion Lines.  The only parameter 
name is Base Line and there can be any number of 
them.

Multiply Used when a multiplication is needed between two 
numbers. The parameter values can only be numbers. 
There can only be two parameters:

BaseLine1 - This is the first parameter in the 
multiplication.
BaseLine2 - This is the second parameter in the 
multiplication.

PerCvg The value in this type of Opinion Line is the number of 
periods covered by the inventory line, when the 
inventory line is consumed by the consume line. This 
type of Opinion Line can only take three parameters:

InventoryLine - The inventory line used to cover the 
values in the consume line.
ConsumeLine - The consume line used to consume 
the values in the inventory line.
MaxPerCvg - The maximum period coverage is 
used when the value in the consume line is too 
small (such as zero) to consume the value in the 
inventory line.

PlusMinus Used when an Opinion Line is the result of the adding 
and subtracting of multiple other Opinion Lines.  There 
are two types of parameters that can be used:

PlusLine - This parameter indicates that the Opinion 
Line set in the parameter value is going to be added. 
MinusLine - This parameter indicates that the 
Opinion Line set in the parameter value is going to 
be subtracted.

Table B-1: Opinion Lines Types

Type Description
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Section 2: Opinion Lines

The table below details all the Opinion Lines that exist on newly created 
Entities. 

ShiftedLine Used when one Opinion Line is the result of another, 
but shifted a specific number of periods in time.  There 
are only two possible parameters:

BaseLine - This is the parameter that specifies the 
original values that should be displayed.
ShiftedPeriods - This parameter indicates the 
number of periods that the original Opinion Line 
should be shifted.

Table B-1: Opinion Lines Types

Type Description

Table B-2: Opinion Lines

Opinion Name Default Type Description Usage/Notes

available Constant Other available demand 
besides the committed order 
arrival.

sequence Input The sequence of each 
observation.

Internal usage.

activeFcst Input Active forecast

openOrder Input Open order. It is the future 
orders from customers. 

actualHist Input Actual shipment. 
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deptDmd Input This Opinion Line represents 
Dependant demand.

Dependant demand is used 
when BOM in DRP is 
enabled. 

monthUnsptDmd Calculated The unsupported demand at a 
period (such as montly) level.

avgInv Calculated The average inventory of 
beginning and ending 
inventories.

recOrder Calculated The Orders suggested by the 
system in order to maintain a 
level of inventory that meets 
the configurations.

recOrderArr ShiftedLine The recommended orders 
would arrive according to what 
the lead time is.

This Opinion Line is the 
same as the recorder 
Opinion Line, but shifted a 
specific number of periods 
or days; by default those 
periods are the Lead Time.

comOrderArr Input The orders that have already 
been committed.

This default type is input, 
which allows the user 
manually enter values for it.  
Note that when Daily DRP is 
enabled and Orders are 
released using the PO 
Launcher, the amounts for 
released orders eventually 
show up in this line.

basicDmd Calculated The basic demand whose 
value is determined by the 
demand type. 

Table B-2: Opinion Lines

Opinion Name Default Type Description Usage/Notes
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totalDmd PlusMinus The total demand, whose 
value is calculated by multiple 
Opinion Lines, depending on 
how the entity is configured.

invTurns Calculated The annual inventory turns.

beginInv Calculated The beginning inventory for 
each period.

endInv Calculated The ending inventory for each 
period.

unsupportedDmd Calculated The demand that cannot be 
met with the current orders 
that have been placed.

minLine PlusMinus The minimum line used for the 
“Min/Max” calculation.

maxLine PlusMinus The maximum line used for 
the “Min/Max” calculation.

reorderPoint PlusMinus The reorder point for the ROP 
calculation.

maxOrderROP Constant The maximum inventory used 
for the ROP calculation.

MinMaxEndPosition PlusMinus The value to determine the 
action message.

Internal usage.

ROPEndPosition PlusMinus The value to determine the 
action message.

Internal usage

dmdCvgTgt Input The Demand Coverage 
Target.

This represents the amount 
of periods that should be 
covered. 

Table B-2: Opinion Lines

Opinion Name Default Type Description Usage/Notes
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cvgDmd Input The demand calculated by 
dmdCvgTgt and totalDmd.

safetyStock Case The final safety stock Opinion 
Line. 

The values are taken from 
different Opinion Lines 
based on the safety stock 
type for this item/series.

ssCvgTgt Input The Safety Stock Coverage 
Target.

This represents the amount 
of periods that should be 
covered.

cvgSS CvgDmdNext The coverage safety stock 
calculated by the ssCvgTgt 
and totalDmd.

statSS Input The statistic safety stock 
Opinion Line.

InternalSS Constant The internal safety stock 
Opinion Line.

Table B-2: Opinion Lines

Opinion Name Default Type Description Usage/Notes
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This chapter includes:

Section 1: Stored Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

Section 1: Stored Procedures

Table C-1: Stored Procedures

Event Description Usage/Notes

DRPBefore This event is executed before 
DRP calculations are run.

This SP is blank by default.  

DRPAfter This event is executed after DRP 
calculations are run.

This SP is blank by default.  

DRPBeforeSeries This event is executed before 
DRP calculations are run on each 
series.

This SP is blank by default.  

DRPAfterSeries This event is executed after DRP 
calculations are run on each 
series.

This SP is blank by default.  

DRPGetAttributes Retrieve all the attributes defined 
in the attributes tab, both from the 
Series and DRPAttribute table.

DRPGetDailyExpandInfor Get the daily expand information

DRPGetDailyDemand Get the daily demand for daily 
DRP

DRPResetDailyOutput Reset daily output in the tables 
configured in the entity.
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DRPSetDailyOutput Save daily output into the tables 
configured in the entity.

DRPResetActionMsg Reset action message.

DRPSetActionMsg Save the action message.

DRPResetDependDmd Reset dependent demand

DRPCalDependDmd Calculate the dependant demand 
of an item.  

It is used when the BOM in DRP 
is enabled.

DRPGetBOMCalOrder Determine the calculation order of 
each series in a scenario when 
BOM is enabled. 

For example if BOM information 
states that item B is a 
component of Item A, then A 
should be calculated before B.

DRPBridgeGetInput Get input data for the daily input 
window.

DRPBridgeGetOutput Get output data for the daily 
output window.

DRPBridgeUpdateData Update the daily input data.

DRPBridgeDeleteData Delete the daily input data.

DRPBridgeGetActionMsgCo
de

Get the action message code from 
configuration.

Internal usage.

DRPBridgeGetDailyActionM
sg

Get daily action message for 
action message window.

DRPBridgeGetBOM Get the Bill of Materials (BOM) 
information.

DRPBridgeUpdateBOM Update BOM information.

DRPBridgeDeleteBOM Delete BOM information.

Table C-1: Stored Procedures

Event Description Usage/Notes
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DRPBridgeUpdatePOUom Update records in the POUom 
table. 

POUom table contains 
information used by the 
Purchase order module and has 
information on Units of 
measure.

DRPBridgeDeletePOUom Delete records in the POUom 
table.

DRPGetRecommendedOrd
erPO

Get recommended order for PO.

DRPSetReleaseOrderPO Set released order for PO.

DRPSPSetDetailPO Set detail PO information.

Table C-1: Stored Procedures

Event Description Usage/Notes
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